Copyright

The 2014 Drake Software Manual Supplement: Corporations, Drake Tax Software, and any other related materials are copyrighted material. All rights are reserved by Drake Enterprises, LTD, including all ownership rights. This document, associated software, and related material are the property of Drake Enterprises, LTD.

Drake Enterprises, LTD, hereby authorizes you to download, display, print, and reproduce the material in this document in an unaltered form only for your personal, non-commercial use or for non-commercial use within your organization. Copyright, trademark, and other proprietary notices may not be removed.

© 2014 Drake Enterprises, LTD. All rights reserved.

While every attempt has been made to produce an accurate and complete manual, there is no warranty, expressed or implied, to that effect. Drake Enterprises, LTD, assumes no liability for damages or claims resulting from the use of the information contained herein.

Trademarks

The Drake Software Logo and Drake Tax are registered trademarks of Drake Enterprises, LTD.

Microsoft® and Windows® are either registered trademarks or trademarks of Microsoft Corporation in the United States and other countries.

Other product names mentioned in this manual may be trademarks or registered trademarks of their respective companies.
# Table of Contents

**What’s New in Drake for Corporations** ................................................. 1
Estimated Taxes Screen .............................................................. 1
Unlimited Forms 2848 ................................................................. 1
New ACA Fields on Form 8941 ...................................................... 2
Reconciliation Totals Displayed .................................................... 2
Force-Printing Final End-of-Year Totals ......................................... 2
Force-Printing Schedule M-3 .......................................................... 3
Missing ID Number ........................................................................ 3
Form 3115 Change ........................................................................ 3
Safe Harbor Elections .................................................................... 4
Form 8878-A ................................................................................ 4
Practice Management Tools ............................................................ 4

**Before You Start.** ........................................................................ 4
Updating a Prior-Year Return in Drake ............................................ 4
Converting from Another Return Type .......................................... 5
Filing Form 1120-C or 1120-H ......................................................... 5

**Header Information** .................................................................... 5
Name and Address .......................................................................... 5
Tax Year ......................................................................................... 6
Boxes A through E ......................................................................... 6

**Income and Deductions** ............................................................. 6
Gross Receipts ............................................................................... 7
Cost of Goods Sold (Form 1125-A) ............................................... 7
Dividends (Schedule C) ............................................................... 8
Interest ......................................................................................... 8
Rents and Royalties ...................................................................... 8
Capital Gains ................................................................................ 8
Ordinary Gains and Losses ........................................................... 9
Other Income (Loss) .................................................................... 9
Compensation of Officers (Form 1125-E) ...................................... 9
Salaries and Wages ..................................................................... 10
Repairs and Maintenance ............................................................. 10
Bad Debts ..................................................................................... 11
Rents ............................................................................................. 11
Taxes and Licenses ...................................................................... 11
Interest ......................................................................................... 11
Charitable Contributions ............................................................. 11
Depreciation ............................................................................... 12
Depletion ...................................................................................... 12
Advertising .................................................................................. 12
Pension and Profit-Sharing ........................................................... 13
Domestic Production Activities .................................................... 13
Other Deductions ....................................................................... 13
Election Statements ................................................................. 31
Safe Harbor Elections .......................................................... 32
**Making Changes on the Fly** .................................................. 32
Suppressing/Forcing Documents .............................................. 32
Calculation and Other Options ............................................... 33
Overriding Other Setup Options ............................................. 33
**Electronic Filing** ................................................................. 34
Common Error Codes ............................................................. 34
**Special Types of Returns** .................................................... 34
E lecting a 52-53-Week Year (Initial Return) ............................. 34
Inactive Returns ................................................................. 35
**Binary Attachments** ........................................................... 36
The PDF Attachment Process .................................................. 36
**Form 3115, Application for Change in Accounting Method** .... 38
Accessing Screens for Changing Accounting Method .................. 38
Form 3115 Screens ............................................................... 39
**Importing Trial Balance Information** .................................... 47
Preparing to Use Trial Balance Import .................................... 47
Preparing Financial Data for Import ....................................... 48
Entering Financial Data .......................................................... 50
Saving a File ................................................................. 52
Importing Data into a Return .................................................. 52
Special Conditions .............................................................. 53
Appendix A: Trial Balance Import ........................................... A-1
**Index** ................................................................................... vii
This page intentionally left blank.
Corporations (1120)

The basics of data entry for a corporation (1120, 1120-C, 1120-H) return are the same as for a 1040 return. Field- and screen-level help, shortcut keys, and navigation throughout data entry all function as they do in the 1040 program. See the Drake Software User’s Manual: Tax Year 2014 for the basics of using the program.

What’s New in Drake for Corporations

Drake programs its tax software according to the latest IRS rules and regulations. The 2014 program reflects all changes to credits and deductions, including discontinuations. For details on the new regulations for the 2014 tax year, see the IRS instructions for Form 1120.

Estimated Taxes Screen

The ES screen has been redesigned this year to provide a way to e-file state estimated tax vouchers and payments, which is required in some states. The functionality of the federal section of the ES screen is unchanged.

The other change is for estimated taxes from multiple states or cities. Rather than filling out several State/City sections on the ES screen, now you press PAGE DOWN and go to a new ES screen.

For details on using the enhanced ES screen for filing federal estimated taxes, and on e-filing and paying state estimated taxes, see “Estimated Taxes,” in Chapter 5 of the Drake Software User’s Manual: Tax Year 2014.

Unlimited Forms 2848

You can now enter an unlimited number of representatives on the redesigned 2848 screen when filling out Form 2848, Power of Attorney. When you need another 2848 screen to enter information on another representative, press PAGE DOWN.
New ACA Fields on Form 8941

Fields were added to the bottom of the 8941 screen to allow you to complete the two new lines at the top of Form 8941, Credit for Small Employer Health Insurance Premiums. These new lines, added by the IRS, determines if employer has provided health care coverage for its employees as mandated by the Affordable Care Act, and determines if the business is eligible to use Form 8941.

Reconciliation Totals Displayed

Schedule L and Schedule M-2 reconciliation totals are displayed on screens L, L2, and M2 to facilitate reconciliation of the balance sheet (item #1 in Figure 1).

![Figure 1: Beginning- and End-of-Year totals displayed on screens L and L2 (#1); force printing end-of-year totals (#2)](image)

Note that the totals from the balance sheet’s subsidiary schedule (SCH2 screen) also appear in the BOY Totals and EOY Totals columns of the L screen.

If you make any changes to the data, recalculate the return (press CTRL+C) for those changes to be displayed on the screen.

NOTE: The end-of-year totals also appear on screen M2 (Retained Earnings). From either screen L, L2, or M2, press PAGE UP and PAGE DOWN to toggle among screens L, L2, and M2 to make reconciliation easier.

Force-Printing Final End-of-Year Totals

Normally, if you mark Final on screen 1, indicating that this as a final-year return, Drake “zeros out” the EOY Totals column of Schedule L. Now, mark the Force-print
**final end of year** check box on screen L (see item #2 in Figure 1) to display those totals in the EOY Totals column.

**Force-Printing Schedule M-3**

Page 1 of Schedule M-3 is required if the balance sheet’s total assets at the end of the year equal or exceed $10 million, and pages 1-3 of Schedule M-3 are required if the total assets equal or exceed $50 million. If the corporation’s assets do not equal or exceed $10 million but you want to voluntarily file Schedule M-3, or if the corporation’s assets do not equal or exceed $50 million and you wish to file the complete M-3, go to screen M3 and make a selection from the Voluntarily file M-3 drop list. Choose to print just page 1 of Schedule M-3 or the complete M-3.

See “Schedules M-1 and M-3 (Reconciliation of Income per Books)” on page 25 for more details on these schedules.

**Missing ID Number**

In the past, if the corporation received a Schedule K-1 from a partnership and the partnership did not have an ID number—for instance, if the partnership was foreign and did not have an EIN—then you typed FOREIGNUS into the Partnership EIN field of the K1P screen. If the partnership had applied for an SSN or EIN but had not yet received an ID number, then you would have typed APPLD FOR in the Partnership EIN field.

Now, to help avoid a data-entry error that might lead to an IRS reject, Drake will autofill the Partnership EIN field. Type F into the Partnership EIN field and FOREIGNUS is automatically entered, or type A and APPLD FOR appears.

**Figure 2:** Drake autofill the Partnership EIN field with “FOREIGNUS” or “APPLD FOR”

**Form 3115 Change**

Form 3115, Application for Change in Accounting Method, is now eligible for e-file. See “Form 3115, Application for Change in Accounting Method” on page 38 for details of using the Drake screens to file this form.

See “Form 3115, Application for Change in Accounting Method” on page 38 for details.
Safe Harbor Elections

A check box was added to screen 4562 to apply a small taxpayer Safe Harbor election to a building listed in the Description field. An election statement will be produced and the building description as entered in the Description field will be included in the election statement.

Two other elections are now available from the Election drop list on the ELEC screen:

- Sec. 1.263(a) - 1(f) de minimis safe harbor election
- Sec. 1.263(a) - 3(n) Election

See “Safe Harbor Elections” on page 32 for more.

Form 8878-A

For electronic payments on extensions, the program now produces Form 8878-A, the IRS e-file Signature Authorization for Form 7004.

Practice Management Tools

For details on additions and enhancements to Drake’s practice management tools—such as the email program, the letters and billing editor, importing client payment information, and the Scheduler—see the Drake Software User’s Manual: Tax Year 2014.

Before You Start

Actions you might need to take before starting a 1120 return in Drake include:

- Updating a prior-year return (if you prepared the tax return last year)
- Changing a return from another type of return to an 1120, if the corporation has made such a change in the last year

Updating a Prior-Year Return in Drake

A prior-year return can be updated in three ways:

- As a single return (updated one at a time) using Last Year Data > Update Clients 2013 to 2014 (recommended)
- When you open a 2013 return for the first time in the 2014 program and are prompted to update it
- With all other returns in the program using Last Year Data > Update Clients 2013 to 2014 (not recommended)

When you update an 1120 return that was marked “final” the previous year, the program informs you that the return was marked final before prompting you to proceed.
Converting from Another Return Type

If the corporation is electing to become an 1120 corporation after existing as another type of entity (S corporation, partnership, etc.), it is necessary to indicate this in the program.

To change from another type of entity to an 1120 corporation in the program:

1. From the Home window, select Tools > File Maintenance > Change File Type.
2. Enter the EIN of the entity and click Continue.
3. Select the new return type.
4. Click Continue to save the change.
5. Click OK.

Filing Form 1120-C or 1120-H

No preliminary steps are required for Forms 1120-C or 1120-H. Use the same screens you might for an 1120 return, but include one of the following screens in addition (accessible from the Other Forms tab of the Data Entry Menu):

- **20C** — For Form 1120-C, U.S. Income Tax Return for Cooperative Associations
- **H** — For Form 1120-H, U.S. Income Tax Return for Homeowners Associations

If one of these screens contains data, the program automatically produces the type of return indicated. For example, if a deduction is entered on screen **20C**, an 1120-C return will be produced.

**TIP**

Is Form 1120-C or 1120-H being produced in error? Check the corresponding screen (**20C** or **H**) for data entered. To delete a screen, open the screen and press CTRL+D.

Header Information

Screen 1 contains fields for the general information that is printed in the top section of page 1 of Form 1120 (or Form 1120-C or 1120-H, as applicable).

Name and Address

Use screen 1 to enter the corporation’s name and address for Form 1120. For state purposes only, if the corporation has an alternate address (such as a P.O. box), you can enter that address on screen 2, State General Information, in the Address Line 2 field at the bottom of the screen.

**NOTE**

The screen 2, State General Information link is located on the States tab of the Data Entry Menu and on screen 1. You can also type 2 into the selector field and press ENTER.
Tax Year

The software uses the calendar year as the default tax period for all corporate returns; no date entries are required on screen 1 for a December 31 tax year end.

Fiscal and Calendar Years

If the corporation uses a fiscal year (where the year begins in the current calendar year and ends in the next), specify the beginning and ending dates in the If not calendar year section in the lower-left corner of screen 1.

The program adjusts calculations for depreciation and for gains and losses on sales of assets based on the entity’s tax year.

For information on filing with a 52-53–week year, see “Electing a 52-53–Week Year (Initial Return)” on page 34.

Short-Year Returns

An entity may have a short-year return if the entity is changing accounting periods with IRS approval (Form 3115), or if this is its first or last year in business and the tax year is not a full year.

To indicate a short-year return, use the fiscal year date fields on screen 1 to indicate the beginning and ending dates for the current year.

If filing a short-year return (other than an initial or final return), you have to provide an explanation. To do so, go to the ELEC screen and select an explanation from the Other short year reason drop list. Your explanation will be displayed at the top of the first page of the tax return. If you do not select an explanation, an EF Message will be generated with the return, and the return cannot be e-filed.

For more information on short-year explanations, see IRS Pub. 4163.

The program may not correctly calculate depreciation, gains, or losses for a short-year return. Depreciation for a short-year return can be entered on screen 4562 and/or screens 6, 7, 8, and 9.

Boxes A through E

Use screen 1 to enter most information for boxes A through E (top of Form 1120). Note that boxes A-4 (“Schedule M-3 attached”) and D (“Total assets”) are completed automatically by the program based on data entered elsewhere.

Box 1a (“Consolidated return”) is automatically marked if there are entries on screen 851 (Form 851, Affiliations Schedule). Box A-2 (“Personal holding company”) is automatically marked if there are entries on screen PH (Schedule PH, U.S. Personal Holding Company (PHC) Tax).

Income and Deductions

Only three screens are required in order to calculate taxable income for a return:

- **INC** — Includes all items of income reported on Form 1120, page 1, lines 1 through 10, that do not require a separate schedule (Schedule C) or additional
information (Income reported on Form 1065, Schedule K-1); also includes tax-exempt interest income reported on the Schedule K.

- **DED** — Includes all deduction items reported on Form 1120, page 1, lines 13 through 26, that do not require a separate schedule or form (Form 4562).
- **J** — Includes loss carrybacks, controlled group tax bracket amounts, tax payment information, and certain credits.

### Gross Receipts

Enter gross receipts (Form 1120, line 1a) and returns and allowances (Form 1120, line 1b) on lines 1a and 1b of the **INC** screen. Exclude any amounts that are to be reported on lines 4 through 10 of Form 1120.

### Cost of Goods Sold (Form 1125-A)

Enter the cost of goods sold (COGS) on screen **A**. Form 1125-A is not produced unless entries are made on screen **A**.

**Note**

On screen **A**, items 9a through 9f are direct-entry fields and follow the format of IRS Form 1125-A. For more information on completing these fields, press F1 or consult the IRS instructions.

**Inventory**

Inventory amounts entered on lines 1 and 7 of screen **A** automatically flow to Schedule L, line 3 (“Inventories”)

**Notes**

Lines 1, 2, and 7 of screen **A** are adjustment fields. Amounts entered in these fields adjust (add to or subtract from) any amount being carried from the **F** screen (Form 1040, Schedule F, Profit or Loss from Farming) to line 2 of Form 1120.

The fields on screen **L** (Schedule L - Balance Sheet - Assets) for line 3 “Inventories” are override fields. Anything entered in these fields overrides (replaces) the data entered for inventory on screen **A**.

**Line 5, Other Costs**

Line 5, “Other costs,” on screen **A** is designated for any applicable costs not entered on lines 2 through 4 (purchases, cost of labor, and additional section 263A costs). In Drake, two data-entry fields are used to complete line 5: one for other costs excluding depreciation, and one for depreciation (Figure 3).

![Figure 3: Screen A (Schedule A), line 5](image)

In the “Depreciation” field, enter any depreciation that relates to the cost of goods sold (unless the amount is flowing from the **4562** (Depreciation - Detail Items) screen with **COGS** selected from the **For** drop list). Note that this field of screen **A** is an
override field; an entry here overrides calculations from the 4562 screen. Amounts entered in this field automatically adjust the total depreciation that is carried to page 1 of Form 1120. An entry in the “Other costs - excluding depreciation” field opens a CTRL+W worksheet. The depreciation amount is included on the statement for other costs and should not be included in the “Other costs - excluding depreciation” worksheet.

### Importing Trial Balance to Sch A

If using the trial balance import feature (see “Importing Trial Balance Information” on page 47), enter depreciation amounts directly into the appropriate fields on the trial balance worksheet, not in the fields in data entry. When the trial balance is imported, the COGS depreciation expense amount flows directly to the appropriate line of Form 1125-A and is calculated accordingly.

### Dividends (Schedule C)

Enter dividends and special deductions on screen C (Schedule C). The Dividends Received Deduction Worksheet (WK_DRD) is generated from data entered in these fields. The result of the WK_DRD is carried to Schedule C of the return. The total from Schedule C, line 19, column A, is carried to Form 1120, line 4 (“Dividends”), and the total from Schedule C, line 20, column C, is carried to Form 1120, line 29b (“Special deductions”).

### Note

If the corporation is filing a consolidated return, do not enter non-included dividends here or anywhere else in the program.

### Interest

Line 5 of Form 1120 is for interest income, which is entered on the INC screen. Note that the Interest income field is an adjustment field; an amount entered there is combined with the interest amount, if any, entered on screen 6252 (Form 6252, Installment Sale Income) and interest income entered on screen K1P (Schedule K-1, Form 1065).

Enter tax-exempt interest income on the INC screen. This amount flows, as applicable, to Schedule K, line 9, and to Schedule M-1, line 7. Override fields are available on screens K and M1 if necessary to override the INC screen amount.

### Rents and Royalties

Enter gross rents and gross royalties using the direct-entry fields on the INC screen. Line 7, “Gross royalties” is an adjustment field. Any amount entered here adjusts amounts flowing from line 7 of screen K1P.

Note that passive activity loss rules may be applied to rental activities held by a closely held corporation or a personal service corporation.

### Capital Gains

Use screen 8949 to enter capital gains and losses. Short-term capital gains flow to Part I, lines 1b, of Schedule D. Long-term capital gains flow to Part II, lines 8b-9, of
Schedule D. The net gain from Schedule D is carried to line 8 of Form 1120. (Any net capital loss is carried to the ATT_D attachment to offset future gains.)

**NOTE**

You can import data for Schedule D using the Form 8949 Import feature. For more on using this feature, see “Form 8949 Imports” in Chapter 5 of the *Drake Software User’s Manual: Tax Year 2014*.  

**Ordinary Gains and Losses**

The amount generated on line 9 flows from screen 4797. Amounts can also flow from screen 4562 to Form 4797 (making screen 4797 entries unnecessary), but only if screen 4562 shows assets sold, date, and property type.

**Other Income (Loss)**

Use the **INC** screen to enter amounts for the “Other income” line of the main form. Specific **INC** screen entries are displayed on attached statements in View mode of the return.

For Form 1120, calculated amounts from the following screens also flow automatically to the “Other income” line (line 10):

- Screen 6478 (Form 6478, Biofuel Producer Credit)
- Screen 8864 (Form 8864, Biodiesel and Renewable Diesel Fuels Credit)

Additional fields for other income on the **INC** screen include:

- Amount of credit for tax on fuels
- Interest income on receivables
- Recoveries of bad debts
- Section 481 adjustments
- State tax refund
- Taxable income from insurance proceeds
- Other (itemize) (Detail worksheet is required.)

**NOTE**

Data from Forms K-1 received from partnerships should be entered on the **K1P** screen (located on the first **Other Forms** tab of the **Data Entry Menu**). This information is reflected in an attached statement in View mode of the return. Losses are included with “Other Deductions” entered on the **DED** screen.

**Compensation of Officers (Form 1125-E)**

Form 1125-E, Compensation of Officers is not generated automatically with the return unless it is required—in other words, unless total receipts (line 1a, plus lines 4 through 10) on Form 1120 are $500,000 or more. To force the software to print Form 1125-E, from the **PRNT** screen, select **Force Form 1125-E, Officer Compensation**.
**Officer Information**

Use screen E to enter officer information and compensation amounts. Press PAGE DOWN to enter additional officers. Screen E totals are calculated and carried to line 12 of Form 1120.

The total of officer compensation can be entered in the Officer Compensation override field on the DED screen (generally used when Form 1125-E is not required). An entry in that field overrides any calculations from screen E, changing lines 12 and 27 of the 1120 but not Form 1125-E.

You may “truncate” the officer’s Social Security Number in the ID number field of screen E. To do so, enter either only the last four digits of the SSN or by entering five zeros and then the last four digits of the SSN. In either case, you must press CTRL+F to “force” the software to accept the truncated number.

**TIP**

Neither “FOREIGNUS” nor “APPLD FOR” is acceptable in the ID number field. Returns with “FOREIGNUS” or “APPLD FOR” in this field are not eligible for e-file.

**Screen E Check Boxes**

Screen E has two check boxes: Signs return and Books in care of. Mark the applicable box on the screen that identifies the officer who either signs the federal or state paper returns, or is the contact person for the books (state return only).

**Ownership & Participation**

The Ownership and Participation fields on screen E are required. Fields are as follows:

- **Total** — Enter the officer’s ownership percentage.
- **Common** — Enter the percentage of common stock owned by the officer.
- **Preferred** — Enter the percentage of preferred stock owned by the officer.
- **Time** — Enter the percentage of time the officer devotes to the corporation.

Enter percentage amounts in whole numbers. For example, enter 40 for 40%.

**Salaries and Wages**

Use the DED screen to enter salaries and wages paid. Note that the DED screen amount is reduced by the amount, if any, of credit from Form 5884. Also note that this is an adjustment field; an amount entered here adjusts any amount entered on screen F (Form 1040, Schedule F, Profit and Loss from Farming) in the “Labor hired” field.

**NOTE**

The Salaries and wages amount should not include compensation of officers. Enter officer compensation data on screen E or as Officer Compensation on line 12 of the DED screen.

**Repairs and Maintenance**

Enter repair and maintenance costs on the DED screen. An amount entered here is combined with the amount, if any, entered in the Repairs and maintenance field on screen F.
Bad Debts

Use the “Bad debts” line on the DED screen to enter the total debts that became worthless in whole or in part during the year, but only to the extent that such debts related to a trade or business activity.

Enter deductible non-business bad debts as a short-term capital loss on screen 8949 (Capital Gains & Losses). Cash method corporations cannot take a bad debt as a deduction unless the amount was previously included in income.

Rents

Use the DED screen to enter rent paid on business property used for a trade or business activity. If the corporation rented or leased a vehicle, enter the total annual rent or lease expense incurred in the trade or business activity of the entity, and then complete Part V of the 4562 (screens 8 and 9).

The Rents field is an adjustment field. An amount entered here is combined with the amount, if any, entered in the Rent fields on screen F, lines 24A and 24b.

Taxes and Licenses

Enter tax and license amounts in the Taxes and licenses section of the DED screen. Amounts are combined and the sum generated on Form 1120, line 17 (“Taxes and licenses”). Note that credit from Form 8846 (Credit for Employer Social Security and Medicare Taxes Paid on Certain Employee Tips) adjusts the line 17 amount.

These amounts also appear on the Taxes and Licenses Attachment (ATT_CTL), referred to on line 17 with an “ATT_CTL” reference. To keep the notification from appearing, go to the PRNT screen (accessible from the General and the Miscellaneous tabs of the Data Entry Menu) and select Suppress printing form and attachment references.

State tax amounts (income tax and franchise tax) entered on the ES (Estimated Taxes) screen are carried to the tax computation (ATT_TAX) worksheet. The state tax amount carried from the ES screen may differ depending on which method of accounting (cash or accrual) is used.

Interest

Enter interest expense on the DED screen. Note that the Interest expense field is an adjustment field. Any amount entered here is combined with the amount, if any, entered in the Interest fields on screen F.

Charitable Contributions

The DED screen provides two fields for entering data for line 19, “Charitable contributions.”
Figure 4: Charitable contribution lines on the DED screen

- **Contributions** — Enter the gross amount of contributions for the year that are subject to the 10% limit on deduction.

- **Qualified conservation contributions** — Enter the gross amount of contributions for the year that are not subject to the 10% limit. These contributions have a carryover period of 15 years; see IRS instructions for details.

The program calculates the contributions allowed and determines carryover capability for amounts entered in both fields for line 19 and reflects the applicable amount on Form 1120. (Refer to the contribution limitation/carryover worksheet (WK_CNTRB) for calculation of allowed amount.) Contribution carryovers from prior years are entered on the LOSS screen.

Note that both fields of line 19 are adjustment fields; entries here adjust amounts flowing from screen K1P, line 13, codes A and B.

### Depreciation

Enter depreciation on the 4562 screen. Select a form from the For drop list (Figure 5) to associate the depreciable item with the correct form or activity. Data from the 4562 screens is calculated and carried to Form 1120 and to the selected schedules or forms.

Figure 5: Selecting Form 1120 from the 4562 screen For drop list

**NOTE**

For more on the For drop list in Drake, see “Associating One Screen with Another,” in the *Drake Software User’s Manual: Tax Year 2014*

### Depletion

Enter depletion deductions on the DED screen. See Form 1120 instructions and Pub. 535 for more information on depletion.

### Advertising

Enter advertising expenses on the DED screen.
Pension and Profit-Sharing

The software reduces this expense based on the credit amount calculated from Form 8881, Credit for Small Employer Pension Plan Startup Costs.

Domestic Production Activities

Use screen 8903 to complete Form 8903, Domestic Production Activities Deduction (DPAD). The calculated total of screen 8903 flows to line 25 of Form 1120.

NOTE

The DPAD is not allowed on returns with a net operating loss (NOL) for the current year. It also cannot be used to create a current-year loss.

Other Deductions

Enter all other deductions on the DED screen. The program calculates these amounts and incorporates the total into line 26 (“Other deductions”) of Form 1120. The following deductions, credits, adjustments, and exclusions also flow to line 26:

- Amortization from Form 4562
- Credit from Form 8820, Orphan Drug Credit
- Exclusion from Form 8873, Extraterritorial Income Exclusion
- Credit from Form 8941, Credit for Small Employer Health-Insurance Premiums

Drake automatically calculates meals and entertainment limitations. A detail (CTRL+W) worksheet is required for the “Other (itemize)” field. The program automatically generates a worksheet if an entry is made here, or in any other field where a worksheet is required by the IRS.

NOL Carrybacks and Carryforwards

Enter NOL carrybacks from future years to the current year on screen J (Loss Carryback, Tax Computation, Payments). To enter multiple carryback amounts, use a detail (CTRL+W) worksheet.

Use the LOSS screen to enter NOL carryforwards, capital losses, and contribution carryforwards from prior years. Use screen J to enter current-year carrybacks to prior years.

Tax, Refundable Credits, and Payments

Screen J has fields for completing the “Tax, Refundable Credits, and Payments” section of Form 1120. Note that some fields are overrides. Press F1 to view more information on a field.
Total Tax

For corporations that belong to a controlled group, complete all applicable fields on screen J. If allocating income to the various brackets on this screen, you must enter 0 (zero) in the fields of the brackets to which no income is allocated.

The total tax from Schedule J is calculated and carried to line 31 of Form 1120.

NOTE

Controlled groups are also required to complete Schedule O. Use the O screen in Drake to complete Schedule O. See “Schedule O (Controlled Group Information)” on page 28.

Estimated Taxes and Applied Refunds

Enter on screen ES the estimated corporation taxes paid. If necessary, use screen W to override 2014 estimated taxes paid and apply any overpayments from 2014 to 2015.

NOTE

Estimate vouchers are not used in federal corporation tax returns.

Overpayment

Overpayments will not be automatically applied unless 2015 estimates are being calculated. If no estimates are required, enter the application of the overpayment using the Overpayment applied override fields.

Quick Refund

To file Form 4466, Corporation Application for Quick Refund of Overpayment of Estimated Tax, go to the PRNT screen (accessible from the General and the Miscellaneous tabs of the Data Entry Menu) and mark the Calculate Form 4466 box. This is the only entry necessary to produce the form. (There is also a link to the PRNT screen from the first Other Forms tab of the Data Entry Menu. Click Application for Quick Refund.)

Underpayment

Use screen 2220 to enter information for Form 2220, Underpayment of Estimated Tax by Corporations. Note that the 2220 screen in Drake consists of two screens. Press PAGE UP and PAGE DOWN to move from screen to screen.

IMPORTANT

The program retains the underpayment and penalty rates as of 12/31 of the calendar year. If a corporation has a fiscal year end, you must enter the effective rates manually.

State Estimates

Enter 2014 estimates and 2015 overpayments for state returns on the ES screen. For the federal return, to override 2014 estimates and apply overpayments to 2015, use screen W.

Direct Deposit of Refunds

The IRS requires that Form 8050, Direct Deposit of Corporate Tax Refund, be submitted with an e-filed return in order for a corporation’s refund to be direct-deposited. To access this form in Drake, go to the DD screen, accessible from the General tab.
When filling out the DD screen:

- If the federal refund is to go to the account listed, select Yes for the Federal selection drop list; otherwise, select No. (Default is Yes.)
- If a state refund is to go to the account listed, select the state abbreviation from the State/City selection drop list.
- Enter the name of the financial institution, the routing number (RTN), the account number, and the type of account (Checking or Savings).
- Re-enter the routing number, account number, and type of account to verify (Figure 6).

![Account Information](image)

**Figure 6**: Federal section of DD screen (also 8050 screen)

If receiving refunds from different state tax authorities, use the State Account boxes on the DD screen to indicate where other state refunds should be deposited.

**Electronic Funds Withdrawal (Direct Debit)**

Use the PMT screen, accessible from the General tab, to indicate that the balance due for an e-filed return should be withdrawn (direct-debited) from an account.

**Program Defaults and Overrides**

By default, the program indicates that the entire balance due (line 34, “Amount owed,” of Form 1120) is to be withdrawn on the return due date. To indicate otherwise, complete the Requested payment date override fields (see Figure 7 on page 16) for the applicable payment. If the return is e-filed on or before the due date, the requested payment date cannot be later than the due date. If the return is transmitted after the due date, the requested payment date cannot be later than the date the return is transmitted.

**Required Information**

A Withdrawal selection (item 1 in Figure 7 on page 16) is required if the program is to direct tax authorities to withdraw funds from the corporation’s bank account.
Withdrawal from Multiple Accounts

Only one account can be designated for direct debit of funds for payment of federal or state taxes. To have state amounts withdrawn from an account other than the account indicated for federal payments, complete the fields in the State Account sections of the PMT screen.

NOTE  Neither the federal nor the state balance due can be paid from more than one account.

Filing an Extension

Calendar year returns are due on March 16, 2015. By filing Form 7004, a corporation can extend the deadline six months to September 15. Fiscal year returns are due on the 15th day of the third month after the end of the corporation’s year. The 7004 extends the deadline six months.

NOTE  An 1120 return is due no later than eight-and-a-half months after the close of the corporation’s tax year.

Use one of the following options to file an extension for an 1120, 1120-C, or 1120-H:

• Go to the 7004 screen in Drake and select Generate an extension. Complete any other applicable fields on the screen.
• Go to the PRNT screen and select Prepare Form 7004 extension based on screen 1 info.
Signing the Return

Electronic PIN signatures are required for e-filed returns. If e-filing a return, complete all fields on the PIN screen. A return cannot be e-filed if the PIN screen fields, including the title and signature (name) of the officer signing the return, are not completed.

An 1120 return must be signed and dated by one of the following individuals:

- The corporation’s president, vice president, treasurer, assistant treasurer, or chief accounting officer
- Any other corporate officer, such as a tax officer, who is authorized to sign

If the return is prepared by a paid preparer, the preparer must complete the required information and sign the return in the space provided on the PIN screen. If it is prepared by an employee or officer of the corporation, go to screen 1 and select NONE in the Firm # and Preparer # drop lists.

To have the preparer’s name and address information displayed on the printed return:

- If the return preparer and ERO (entered in Setup > ERO) are the same:
  - Go to Setup > Preparer(s) and ensure that the Alternative Electronic Signature box is marked for the preparer.
  - Complete the PIN screen for the return.
- If the return preparer and ERO are not the same:
  - Go to the PRNT screen for the return and complete the field labeled PIN for preparer’s alternative electronic signature. The PIN entered should match the one entered for the preparer in Setup > Preparer(s). (For more information, press F1 in this field.)

**NOTE**

Setup > ERO must still be completed in Drake for e-filing. For information on how to complete this setup window, see Drake Software User’s Manual: Tax Year 2014. See the IRS instructions for further details on signature requirements.

Amending a Return

The program can automatically fill the 1120X screen for Form 1120X, Amended U.S. Corporation Income Tax Return.

**CAUTION**

When you amend a return in Drake, the amended information replaces the original in the data file. Before amending a return, you should archive the original to avoid losing previously submitted data. For more information on archiving returns, see “Archive Manager” in Chapter 6, “Return Results,” of the Drake Software User’s Manual: Tax Year 2014.

From the Data Entry Menu of an 1120 return, enter an X in the selector field and press ENTER. (Screen X is also accessible from the first Other Forms tab.) At the prompt, select Yes to automatically fill the screen with data from the original return (that is, the return as originally entered in Drake). If the corporation’s name or address...
information has changed, enter the new information on screen X. Make all other necessary changes to the regular data entry screens.

Open screen 2X (or press PAGE DOWN while in screen X). Enter the line number from the X screen that corresponds with the changes that were made in data entry. (For instance, if you made a change in the tax on screen J, enter 4 (for “Tax”) in the Line Number field of the 2X screen.) Enter an explanation in the Explanation of changes text box.

If more than one item was changed in data entry, press PAGE DOWN to open another screen 2X. Enter the line number from screen X that corresponds to this change and enter another explanation.

When you go to View mode, the program calculates the amended return.

New Returns
To amend a return not previously prepared in Drake, create an 1120 return in Drake and open screen X. Complete the applicable fields on this screen, and then enter the amended data in the appropriate other screens, as described in the example below.

Example: An 1120 return was filed using a different tax software, but gross rental income was not reported on line 6 of the return. To amend the return:

1. From the Data Entry Menu of an 1120 return, open screen X.
2. Complete all applicable fields on screen X.
3. Close screen X and open the INC screen.
4. Enter the amount of unreported income on line 6.
5. Close the INC screen and open screen 2X.
6. Enter the line number from the X screen that corresponds to the changes that were made in data entry. (For this instance, if you made a change to income on the INC screen, enter 1 (for Total Income) in the Line Number field of the 2X screen.
7. Enter an explanation in the Explanation of changes text box.
8. Calculate and view the return. Note the adjustments made on the Form 1120X.

E-filing an Amended Return
To add Form 1120X to the queue for e-file go to the EF screen for the return (accessible from the General tab of the Data Entry Menu) and mark the 1120-X box. For detailed instructions on e-filing the returns in the queue, see Chapter 8, “e-File,” in the Drake Software User’s Manual: Tax Year 2014.

Schedule K
Use screen K to enter data for Schedule K, Other Information. Screen K should also be used for Schedule K of Form 1120-C. Detailed here are some specific areas that might need your attention.

Schedule K, Line 3
On line 3 (line 5 for 1120-C), enter the EIN and name of the parent corporation if the corporation is a subsidiary in an affiliated group or a parent-subsidiary controlled group.
Be aware of the following guidelines from the IRS:

- “If the corporation is an “excluded member” of a controlled group (see definition in the Instructions for Schedule O (Form 1120)), it is still considered a member of a controlled group for this purpose.
- “An affiliated group is one or more chains of includable corporations (section 1504(a)) connected through stock ownership with a common parent corporation. The common parent must be an includable corporation and the following requirements must be met.
- “The common parent must directly own stock that represents at least 80% of the total voting power and at least 80% of the total value of the stock of at least one of the other includable corporations.
- “Stock that represents at least 80% of the total voting power and at least 80% of the total value of the stock of each of the other corporations (except for the common parent) must be owned directly by one or more of the other includable corporations.
- “For this purpose, the term ‘stock’ generally does not include any stock that (a) is nonvoting, (b) is nonconvertible, (c) is limited and preferred as to dividends and does not participate significantly in corporate growth, and (d) has redemption and liquidation rights that do not exceed the issue price of the stock (except for a reasonable redemption or liquidation premium). See section 1504(a)(4).

**Schedule K, Line 4**

If a corporation, partnership, trust, individual, or estate owned, directly or indirectly, 20 percent or more, or owned, directly or indirectly, 50 percent or more of the total voting power of all classes of the corporation’s stock entitled to vote, the applicable data appears on Schedule G. In Drake, Schedule G data is entered on screens **G1** and **G2**, accessible through the **G1 Screen** and **G2 Screen** links on line 4 of screen **K**, or from the **General** tab of the **Data Entry Menu**.

If the stock is owned by *any foreign or domestic corporation, partnership, or trust*, enter on screen **G1** the name and EIN of the entity, the type of entity (corporation, partnership, or trust), the country of the entity’s organization, and the percentage of stock the entity owns.

If the stock is owned by an *individual or estate*, enter on screen **G2** the name and ID number of the individual or estate, country of citizenship, and percentage of stock owned.

Use the **CTRL+PAGE DOWN** function to open additional (blank) **G1** or **G2** screens. For more information on line 4 of Schedule K, see the IRS instructions.

**Schedule K, Line 5**

If the corporation owned stock in other corporations or partnerships, or the beneficial interest in a trust, enter the information on the **K5A** or **K5B** screen. Click the **K5A Screen** or **K5B Screen** links on the **K** screen or from the **General** tab of the **Data Entry Menu** to access fields for entering this information.
Use the CTRL+PAGE DOWN function to open additional (blank) K5A or K5B screens. For more information on line 5 of Schedule K, see the IRS instructions.

**Schedule K, Line 7**

Enter information on line 7 of screen K if a foreign person owned, directly or indirectly, at least 25% of the total voting power of all classes of the corporation’s stock entitled to vote, or the total value of all classes of stock of the corporation. (If there is more than one 25%-or-more foreign owner, complete the fields for the person with the highest percentage of ownership.) Enter the percentage that person owned and the owner’s country of residence.

**NOTE**

Generally, a 25% foreign-owned corporation with a reportable transaction during the tax year must file Form 5472, Information Return of a 25% Foreign Owned U.S. Corporation or a Foreign Corporation Engaged in a U.S. Trade or Business (screen 5472 in Drake). See Form 5472 for filing instructions and penalties for failure to file.

See section 6038A(c)(5) and the related regulations for the constructive ownership rules of section 318 that apply in determining if a corporation is foreign owned.

**NOTE**

If another entity owns 20% or more of the client’s corporation, or owns 50% or more of the corporation’s stock entitled to vote, see “Schedule K, Line 4” on page 19.

**Schedule K, Line 13**

On line 13 of screen K, select Yes if the corporation’s total receipts (line 1a + lines 4 through 10 on page 1 of Form 1120) are less than $250,000 for the tax year, and its total assets at the end of the tax year are less than $250,000.

If the answer to line 13 is Yes, in the lower text box of line 13 enter the total amount of cash distributions and the book value of property distributions (other than cash) made during the tax year. (An entry here is added to the amount calculated from entries on line 5 (Distributions) on the M2 screen and reflected on page 4, line 13, of the 1120 return.)

**NOTE**

If the answer on line 13 is Yes, the corporation is not required to complete Schedules L, M-1, or M-2. To force the software to print these forms, go to the PRNT screen and select Force Schedules G (1120-C), L, M-1, and M-2 to be printed.

**Schedule K-1**

The 1120 package includes a K1P screen (accessible from the first Other Forms tab of the Data Entry Menu) for entering information from Form 1065, Schedule K-1. This screen works the same as it does for the other packages, with amounts being carried automatically to the appropriate forms, schedules, and lines. In addition:
• Ordinary income is carried to Form 1120, page 1, line 10, “Other income,” with the partnership name and EIN (required information)
• Ordinary losses are carried to Form 1120, page 1, line 26, “Other deductions,” with the partnership name and EIN (required information)

Codes or lines that don’t flow to any other place may require additional information not available to the program and must be manually entered in the proper place in the return.

State-Specific Information

The program automatically generates a return for the corporation’s resident state. Use screen 2 to enter company information as it should appear on the state return.

NOTES

The link to screen 2 is on the States tab, (or enter 2 in the selector field and press ENTER.)

The company information fields on screen 2 apply for the resident state only.

Company information includes the type of return that applies for state purposes (consolidated, composite, controlled group, multi-state), and state-specific dates and numbers for identification.

Contact Information

If certain contact information required for state purposes is different from that entered on screen 1, use screen 2. This screen has fields for the following types of contact information:

• Name and address of registered agent
• Principal place of business
• “Books in care of”
• General contact information for the name, title, e-mail address, ID number, and telephone number of the corporation’s contact person.

Other States

Data for other states must be entered manually in state data entry. To access state data entry, select the States tab from the Data Entry Menu, or enter the two-letter state code in the selector field and press ENTER.

Multi-State Apportionment

Enter sales, payroll, and property factors on the APPT Multi-State Apportionment screen. This screen (Figure 8 on page 22) provides one central location for entering all state apportionment information instead of having to open each needed state’s screen.

In addition to making data input faster and easier, this feature provides two worksheets: a summary worksheet (SA-SUM~) that can be used for verifying input, and a reconciliation worksheet (SA-REC) that ties the total of the state amounts to the federal return figures. These worksheets are available in View mode.
The individual state apportionment screens will continue to be available in Drake15 but will be used to override data entered on the APPT screen. No state apportionment-related screens will be updated from Drake13 to Drake14.

Mark the Zero Apportionment check box (Figure 8) to add a state but not include any apportionment data. This will include the state on the apportionment summary worksheet (SAC-SUM~), available through View mode.

### APPT Screens

The APPT screen is opened to the Sales tab. Links at the top of this screen open the Payroll, Property, and Additional Property information tabs for each state selected. These screens and their uses are listed in Table 1:

<table>
<thead>
<tr>
<th>Screen</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales</td>
<td>Select state; enter sales, returns and allowance, and other income-related information for each selected state</td>
</tr>
<tr>
<td>Payroll</td>
<td>Enter salary, wage, commission, and labor amounts for each selected state</td>
</tr>
<tr>
<td>Property</td>
<td>Enter beginning and ending amounts of common apportionment factors, plus select additional apportionment factors from drop lists</td>
</tr>
<tr>
<td>Additional Property</td>
<td>Select additional apportionment factors from drop lists</td>
</tr>
</tbody>
</table>

The Ending amount entered on the Property and Additional Property screens in Drake14 will become the Beginning amount for property on the APPT screen when the client’s return is updated next year in Drake15.
You may enter up to four states on one APPT screen. If you need more than four states, press PAGE DOWN for a new APPT screen. The same state can be entered more than once when additional fields are needed.

Select OT Other Reconciliation from the State Selection drop list when using the reconciliation worksheet. Not every item appearing on the federal return may be subject to multi-state apportionment. When you select OT, the data entered becomes a reconciling adjustment amount to aid in tying to the federal return.

Enter as much or as little detail as the states require. If a state does not require any information to be entered, no information will flow to that state’s return.

**Other Information and Overrides**

Use screen 1 to enter the following additional information:

- **Resident State** — If the corporation has a mailing address in one state but does business in another, select the state in which the corporation does business from the Resident State drop list.

- **Drake Codes and Overrides** — Screen 1 includes fields for miscellaneous codes, invoice numbers, and several overrides. See “Listing a Different Firm, Preparer, or ERO on a Return” in Chapter 2 and “Miscellaneous Codes” in Chapter 5 of *Drake Software User’s Manual: Tax Year 2014* for more information.

**Schedule L (Balance Sheet per Books)**

Schedule L is required if the corporation’s total receipts for the tax year or its total assets at the end of the year are greater than $250,000.

**Flow of Information**

Many of the entries made elsewhere (such as inventory information from Schedule A) flow automatically to the generated Schedule L. Depreciable asset information from the 4562 screen and intangible assets and amortization also flow to Schedule L.

Use the corporation’s balance sheet to enter data directly onto Schedule L.

**NOTE** See “Importing Trial Balance Information” on page 47 for information on using the trial balance import to enter Schedule L data.

**The SCH2 Screen**

The SCH2 screen (see Figure 9 on page 24) is used to provide detailed information required by the IRS for certain lines on Schedule L. The amounts are carried to Form 1120 and printed on an attached statement.
This screen can also be used in place of the actual L screen in Drake. If you use this screen for all applicable lines on Schedule L, you do not need to make any entries on screen L.

**NOTE**

To access the SCH2 screen from screen L, click an SCH2 Screen link. Press Esc to return to screen L.

**Entering Information**

To create a statement for a line using the SCH2 screen, select the desired line from the **Line Number** drop list and enter descriptions and their corresponding amounts.

![Figure 9: SCH2 screen fields for line number, description, and amounts](image)

Once the information is entered, or if additional descriptions are required for the line, press PAGE DOWN to access a new screen.

**NOTE**

All line selections and screen descriptions are carried to the next year, and year-end amounts are carried to the beginning-of-year column, when the returns are updated.

**Statements**

The total amounts entered on the SCH2 screen do not show up on the actual L screen in the program. They are, however, printed on the return where needed, with references to the corresponding statements.

If a line is required, a statement (labeled “STATEMENT” or “STM” in View mode, depending on your Setup Options) is produced and is e-filed with the return.

**SCH2 and Trial Balance Import**

Typically, one or more SCH2 screens are needed for Schedule L items. Data for the SCH2 screens cannot be entered directly into the trial balance worksheet. Although the amounts must be included in the trial balance worksheet for the worksheet to balance, the SCH2 detail screens must be created separately from the worksheet. When the return is produced, Schedule L will reflect both the amounts imported from the trial balance worksheets (where direct entry was allowed) and the totals of the SCH2 screen amounts.

See “Importing Trial Balance Information” on page 47 for detailed instructions using the trial balance worksheet for SCH2 items and amounts.
Autobalance

Autobalance forces Schedule L to balance for both the beginning- and end-of-year amounts. The program adjusts the unappropriated retained earnings amount on Schedule L by the difference between the total assets and the total liabilities and capital before the adjustment. For example, if assets are $1,000 and liabilities and capital are $900, the program increases the unappropriated retained earnings by $100.)

The program makes the adjustments due to differences in the balance sheet. Incorrect data entry could cause these differences but they are usually the result of one of the following issues:

- An asset was deleted from 4562 screen (Depreciation - Detail Items) instead of being indicated as sold.
- Beginning inventory amounts were adjusted on the Schedule A or ending inventory amounts were entered incorrectly.
- Amounts were erroneously deleted from or changed on screen L.

To reconcile the differences, it is best to compare the corporation’s beginning and ending balance sheet amounts for the tax year.

To turn off this feature for a specific return, go to the PRNT screen and select Turn off autobalance.

NOTE

If you are using trial balance import, autobalance must be turned off prior to import. See “Preparing to Use Trial Balance Import” on page 47.

Schedules M-1 and M-3 (Reconciliation of Income per Books)

Page 1 of Schedule M-3 is required if the balance sheet’s total assets at the end of the year equal or exceed $10 million, and pages 1-3 of Schedule M-3 are required if the total assets equal or exceed $50 million. If the corporation’s assets do not equal or exceed $10 million but you want to voluntarily file Schedule M-3, or if the corporation’s assets do not equal or exceed $50 million and you wish to file the complete M-3, go to screen M3 and make a selection from the Voluntarily file M-3 drop list. Choose to print just page 1 of Schedule M-3 or the complete M-3.

NOTE

If the corporation is filing Schedule M-3, Schedule M-1 will not be generated. Any entries on the M1 screen (for Schedule M-1) should be deleted.

Schedule M-1

Schedule M-1 shows all items of income and expense that are not subject to tax, plus those accounting items that are not income tax items. When required, the corporation must reconcile book income with the taxable income.
Use the **M1** screen to enter book-to-tax difference for Schedule M-1. Book-to-tax differences are classified as “permanent” or “temporary,” and as “favorable” or “unfavorable.” Examples of both kind of differences are shown in Table 2.

**Table 2: Examples Book-to-Tax Differences for Schedule M-1**

<table>
<thead>
<tr>
<th>Difference</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
</table>
| Permanent  | Book or tax items that will never be reported for book or tax purposes | - Meals & entertainment limitations  
- Penalties  
- Tax-exempt interest |
| Temporary  | Items that will be reported for both tax and book purposes, but not during the same tax year | - Depreciation  
- Gains or losses on the sale of depreciated assets |
| Favorable  | Items that reduce taxable income | - Instances in which tax depreciation amount is greater than book depreciation amount |
| Unfavorable| Items that increase taxable income | - Disallowed meals & entertainment |

**Schedule M-3**

Schedule M-3 is completed using the following screens, all found on the **General** tab of the Data Entry Menu:

- **M3, M31, M32, and M33** — for Parts I, II, and III of the Schedule M-3
- **M3B** — for Schedule B Additional Information for M-3 filers
- **SCH3** — for subsidiary schedules for Schedule M-3 and Form 8916-A
- **M3S** — for supplemental statements
- **8916** — for reconciling of M-3 with taxable income for mixed groups
- **916A** — for supplemental attachments to the M-3

If the corporation is required to file (or voluntarily files) Schedule M-3, the corporation **must** file Form 1120 and all attachments and schedules, including Schedule M-3.

**NOTE**

Certain income and deduction amounts and adjustments flow from Form 1120 to Schedule M-3 and Form 8916A in the program, but all other M-3 data must be entered manually.

If Schedule M-3 is present in a return, no Schedule M-1 is generated.

**Parts I-III**

Part I of Schedule M-3 asks certain questions about the corporation’s financial statements and reconciles financial statement worldwide net income (loss) for the corporation (or consolidated financial statement group, if applicable) as reported on Schedule M-3, Part 1, line 4, to net income (loss) per the income statement of the corporation for U.S. taxable income purposes, as reported on Schedule M-3, Part 1, line 11.

Parts II and III reconcile financial statement net income (loss) for the U.S. corporation (or consolidated tax group, if applicable) as reported on Schedule M-3, Part II, line 30 (column d), to taxable income (loss) as reported on Form 1120, page 1, line 28.
The software carries certain items that are readily available, but it does not balance the M-3 automatically. To ensure that the M-3 balances, additional data entry may be required on the M31, M32, and M33 screens.

**Schedule B**
Schedule B is required when an M-3 is present in a return. Use screen M3B for Form 1120 Schedule B, Additional Information for M-3 Filers.

**The SCH3 Screen**
The SCH3 screen is similar to the SCH2 screen and is used to provide detailed information for Schedule M-3 and Form 8916-A. It can be used in place of the actual M3 and 8916A screens. For more information on using this type of screen, see “The SCH2 Screen” on page 23.

**Schedule M-2 (Unappropriated Retained Earnings)**
Information from Schedule M-2, “Analysis of Unappropriated Retained Earnings” ties to the Schedule L, line 25, portion of the balance sheet. Increases, distributions, and other decreases to the retained earnings are entered on Schedule M-2. Unappropriated retained earnings refer to corporation income that has not been distributed to shareholders that is available for dividend distribution.

**M-2 Troubleshooting**
The beginning Unappropriated Retained Earnings flow from Schedule L (Balance Sheet), and the “Net Income (Loss) per books” flows from the completed Schedule M-1 or M-3 on Form 1120. These numbers, combined with amounts entered on the M2 screen, are used to calculate the ending Unappropriated Retained Earnings.

If the computed amount does not match the amount in the completed Schedule L (Balance Sheet), the system produces an EF message that says the M-2 is out of balance. Solving this problem can be challenging, since it can have any of several causes:

- The beginning balance sheet entries are inaccurate
- The Beginning of Year unappropriated retained earnings amount (line 25 on screen L) entered on the SCH2 screen for line 24 (Retained earning-Appropriated) is incorrect
- Autobalance is not turned on (See “Autobalance” on page 25.)
- The ending balance sheet entries are inaccurate
- The net income per the tax return is inaccurate
- The reconciling items on Schedule M-1 or M-3 need to be adjusted
- The reconciling items on Schedule M-2 need to be adjusted.

If the items are off by a couple of dollars or less, resolve the problem by entering a reconciling item on the M2 screen:

1. Double-click in a field on the M2 screen to open a detail (CTRL+W) worksheet.
2. Enter the word “Rounding” as the description and enter an amount.
3. Press Esc. The program returns to the M2 screen.
If the problem is not resolved, it may be necessary to do a detailed comparison between the corporation’s financial records and the completed return information.

Schedule O (Controlled Group Information)

Use screens O and OM, accessible from the first Other Forms tab, to fill out Schedule O, Consent Plan and Apportionment Schedule for a Controlled Group. Press PAGE UP and PAGE DOWN to navigate from screen to screen.

**NOTE**

Members of a controlled group are entitled to one $50,000, one $25,000, and one $9,925,000 taxable income bracket amount, in that order.

AMT Adjustments and Other Items

Alternative Minimum Tax (AMT) adjustments are limited among the members of a controlled group. These should be entered in the Other information fields of the OM screen (Figure 10).

![Figure 10: Other information fields for other AMT adjustments](image)

Types of Controlled Groups

At the top of screen O, mark the box indicating the type of controlled group for which Schedule O is reporting. Controlled group types are briefly defined below. See Schedule O instructions for more details.

- **Parent-subsidiary group** — One or more chains of corporations that are connected through stock ownership with a common parent corporation if certain conditions apply.
- **Brother-sister group** — Two or more corporations if the same five or fewer persons who are individuals, estates, or trusts directly or indirectly own stock of each corporation with a certain amount of voting power.
- **Combined group** — Three or more corporations, each of which is part of a parent-subsidiary group or a brother-sister group, and one of which is (1) a common parent corporation included in a group in a parent subsidiary group, or (2) included in a group of corporations in a brother-sister group.
- **Life insurance companies only** — Two or more insurance companies subject to tax under section 801, that are members of one of the previously described groups, are treated as a particular type of controlled group.
Line 5, Apportionment Plan Status

The corporation is required to provide information about the status of the group’s apportionment plan. Select the applicable box on screen O to show the status of the controlled group’s apportionment plan. If adopting a plan or amending the current plan for a prior tax year, at least one year must remain on the statute of limitations for each group member for assessing any resulting deficiency.

Credits and Adjustments

Certain credits require an adjustment to either income or expenses. Drake14 carries the required adjustments to the appropriate line of the return and to Schedule M-1 or M-3. Manually reducing the expenses/deductions or increasing the income for these credits causes the return to be out of balance.

Adjustments are made to other income for the credit amounts for the following credits:

- Form 6478, Biofuel Producer Credit
- Form 8864, Biodiesel and Renewable Diesel Fuels Credit
- Form 8912, Credit to Holders of Tax Credit Bonds (interest income)

Adjustments are made to the appropriate deduction/expenses for the credit amounts for the following credits:

- Form 5884, Work Opportunity Credit
- Form 6765, Credit for Increasing Research Activities
- Form 8820, Orphan Drug Credit
- Form 8844, Empowerment Zone and Renewal Community Employment Credit
- Form 8845, Indian Employment Credit
- Form 8846, Credit for Employer Social Security and Medicare Taxes Paid on Certain Employee Tips
- Form 8881, Credit for Small Employer Pension Plan Startup Costs
- Form 8932, Credit for Employer Differential Wage Payments
- Form 8941, Credit for Small Employer Health Insurance Premiums

Adjusting Charitable Contributions/NOL

Corporations with a net operating loss (NOL) carryover from any taxable year must apply the special rule of IRC section 170(d)(2)(B) for charitable contributions. The rules are designed to prevent a double tax benefit through interaction of NOL and charitable contribution carryovers. The excess charitable deduction can reduce taxable income only once. Under these rules, a corporation’s charitable contributions carryover (but not the NOL carryover) must be reduced to the extent the charitable contribution deduction, in computing the taxable income of an intervening year, would increase the NOL to a succeeding year.
**Limitation on Deduction**

The total amount claimed cannot be more than 10% of taxable income (line 30) computed without regard to the following:

- Any deduction for contributions
- The special deductions on line 29b
- The deduction allowed under section 249
- The domestic production activities deduction under section 199
- Any net operating loss (NOL) carryback to the tax year under section 172
- Any capital loss carryback to the tax year under section 1212(a)(1)

To prevent the double benefit from the excess charitable contribution deduction when there is a charitable contribution on the return and an NOL carryover, the program makes the IRC section 170(d)(2)(B) adjustment. In this situation, the charitable contribution carryover amount is reduced on column C of the Contribution Limitation/CARRYOVER worksheet (WK_CNTRB in View mode), and the NOL carryforward is increased on the ATT_NOL worksheet.

**Elections**

The ability to make certain tax elections is included in the business packages. Elections are selected from the Return Elections section of the ELEC screen (Figure 11).

![Figure 11: Return Elections portion of ELEC screen](image)

**Making an Election in Drake**

To indicate that the corporation is making an election:

1. Open the ELEC screen (accessible from the Miscellaneous tab of the Data Entry Menu (or by typing ELEC in the selector field and pressing ENTER).
2. Make a selection from the Election drop list (Figure 12 on page 31).
3. Complete all other fields as applicable. Press F1 in any field to learn if a field is required for your selection and the type of information that may be needed. For example, the help text for the Date or year-ending field shows that the field is required only for election options 08, 09, 11, and 15, and it explains what, specifically, should be entered for each of these elections.

If the election option you selected is not listed in the help text for a field, then that field should be left blank. For example, if you chose election 01 (General Election Statement), you would not need to enter anything into the Date or year-ending field (help text in Figure 13).

To open a new ELEC screen for an additional election, press PAGE DOWN.

**Election Statements**

Once an election is made and the return is calculated, the election information is produced on a statement referenced “STM ELXX,” where “XX” is the number of the election. For example, election 01 (General Election Statement) is generated as STM EL01.

The election statement includes the election title, election wording, and any additional information required for the election, such a date or amount.

Entries for certain fields are sometimes included in the actual election statement; other times, they are included as separate lines. Signature lines are printed as needed on some statements.
Safe Harbor Elections

New for 2014: A check box was added to screen 4562 to apply a small taxpayer Safe Harbor election to a building listed in the Description field. An election statement will be produced and the building description as entered in the Description field will be included in the election statement.

NOTE
This Safe Harbor election covers buildings only.


New Options on ELEC Screen

Two other elections are now available from the Elections drop list on the ELEC screen:

• Sec. 1.263(a) - 1(f) de minimis safe harbor election
• Sec. 1.263(a) - 3(n) Election

Election statements are generated with the return (Figure 14).

Figure 14: Election statement generated with ELEC screen selection

The Sec. 1.263(a) - 3(h) election can be made from either the ELEC screen or the 4562 screen.

Making Changes on the Fly

Use the PRNT screen to override most program defaults.

Suppressing/Forcing Documents

To suppress or force the printing of certain documents, go to the PRNT screen and select the desired options. Many "on-the-fly" changes override the options established in Setup.

You can force the program to print the following 1120 items on a return:

• Form 1125-E
• Schedules G (1120-C), L, M-1, and M-2
• Form 4562
• Next-year depreciation listing
• Inactive returns
• PIN for the preparer’s alternative electronic signature

**NOTE**

Form 1125-E is required if total receipts (line 1b + lines 4 through 10) are $500,000 or more.

Schedules L, M-1, and M-2 are not required if receipts and total assets (Schedule K, line 13) are less than $250,000.

The **PRNT** screen can also be used to suppress printing of the following items on a return:

• Form and attachment references (References are printed by default.)
• Form 4626, Alternative Minimum Tax—Corporations

**Calculation and Other Options**

The following calculation and other options are available:

• **Calculate Form 2220 penalty** — Select this box to have the program calculate the penalty for Form 2220, Underpayment of Estimated Tax by Corporations. (The program retains the rates as of 12/31 of the calendar year. If a corporation has a fiscal year end, the preparer must enter the effective rates manually.)

• **Calculate WK_1120W based on 2014 taxable income** — The WK_1120W is an estimated tax worksheet based on the current tax year taxable income.

• **Calculate Form 4466 (application for quick refund)** — Form 4466, Corporation Application for Quick Refund of Overpayment of Estimated Tax. (A check mark in this box is the only entry needed to generate the form.)

• **Turn off autobalance** — For more information on the autobalance feature in Drake, see “Autobalance” on page 25.

• **Prepare Form 7004 extension based on screen 1 info** — Select this box to prepare a six-month extension based on the information that has already been entered into the return. Note that screen 1 must be completed to prepare an extension.

**NOTE**

To prepare Form 7004 based on information other than (or in addition to) that provided on screen 1, use the **7004**, or **EXT**, screen.

**Overriding Other Setup Options**

The following program defaults can be overridden from the **PRNT** screen:

• Filing instructions (federal and state)
• Envelope coversheets (corporation, IRS, state, and city)
• Date to print on return
• Due date to print on letter and filing instructions (see note below)
• Amount on Form 1120, page 1, item D (“Total assets”)
• IRS Service Center

**NOTE**

A default due date for filing is printed on all letters and filing instructions generated with a return. You can override the default by entering an alternate due date in the **Due date to print on letter and filing instructions** field on the PRNT screen.

### Electronic Filing

Steps for e-filing Form 1120 are the same as for e-filing Form 1040, with the exception of bankruptcy returns, which must be paper-filed.

### Common Error Codes

If one or more of the following IRS error reject codes is generated when e-filing an 1120 return, the preparer must contact the IRS for further information. The IRS e-Help Desk telephone number is (866) 255-0654.

- **Reject Code F1120-307-01** — Filer’s TIN and “Name Control” in the return header must match data in the e-file database unless Form 1120, Item E (3), check box “Name Change” is marked.
- **Reject Code R0000-900-01** — The return type indicated in the return header must match the return type established with the IRS for the EIN.
- **Reject Code R0000-905-01** — Electronic Filing Identification Number (EFIN) in the return header must be listed in the e-file database and in “accepted” status. If you get this reject code, you must update your e-file application to include the 1120 return type. This should be done at the IRS website. Review publication 3112 for details.
- **Reject Code R0000-932-01** — If “Amended Return” or (Superseded for 1120/1120S) check box is not selected, then Taxpayer TIN in the return header must not be the same as a TIN of a previously accepted paper return for the return type and tax period indicated in the tax return.
- **Reject Code R0000-933-01** — If “Amended Return” or (Superseded for 1120/1120S) check box is not selected, then Taxpayer TIN in the return header must not be the same as a TIN of a previously accepted electronic return for the return type and tax period indicated in the tax return.

### Special Types of Returns

This section covers 52-53–week year returns and inactive returns. Both types of returns can be e-filed using Drake.

### Electing a 52-53–Week Year (Initial Return)

To elect a 52-53–week year, a **new** entity (one that has never filed a return) must enter data on both screen 1 and the ELEC screen.

To elect a 52-53–week year for any entity:
1. In the **If not calendar year** section of screen 1, enter the **Fiscal year beginning** and **Fiscal year ending** dates. Use MMDDYYYY format, as shown in the example in Figure 15.

2. Mark the **52-53-week tax year** box.

![Figure 15: In this example, the fiscal year begins 09/24/2014 and ends 09/30/2015 (the Wednesday closest to the end of September), giving the entity a 53-week year for 2014.](image)

**NOTE**

An entity that has filed returns in the past must complete only steps 1 and 2 of this process. An entity that has never filed a return before must continue with steps 3 through 6.

3. Click the **ELEC** link to open the **Election Options** screen (Figure 16).

![Figure 16: Elections for 52-53-week tax years](image)

4. For line 1, select the month in which the 52-53–week year ends for the current fiscal year. (01 = January, 02 = February, etc.)

5. For line 2, select the day of the week the tax year always ends.

6. For line 3, enter the actual date that the tax year ends (the same date entered in the **Fiscal year ending** field on screen 1).

**NOTE**

Once a 52-53–week year is selected, the entity must use that accounting period every year. To change accounting periods, the entity must submit to the IRS Form 3115, Application for Change in Accounting Method.

In subsequent years, only the **52-53–week tax year** check box on screen 1 must be marked; the program automatically updates the dates.

### Inactive Returns

Entities that are inactive but still required to file returns may e-file inactive returns in Drake. To indicate that a return is inactive:

1. Go to the **PRNT** screen, accessible from the **General** tab.

2. Under **Items to Print**, mark the **Print inactive return** box.
When the return is calculated, the program displays the words “Inactive Return” on the main form of the return (specifically, in the box above line 1c). Zeros are displayed where required by the IRS in order for amounts to be properly included in the e-file data.

**IMPORTANT** All EF Messages must be cleared in order to e-file an inactive return.

For detailed instructions on e-filing returns in Drake, see *Drake Software User’s Manual: Tax Year 2014*.

**Binary Attachments**

Binary, or PDF, files can be attached to certain tax forms. These attachments are generally signature or third-party documents such as a copy of a signed lease or a signed appraisal statement. In some instances, the IRS requires that a document be attached to an e-filed return; in other instances, a document can be attached voluntarily to support or explain an entry in the return. In either case, a PDF must be available to be attached to the return in order to be e-filed with the return.

Attach files through the PDF Attachments screen, accessible from the Electronic Filing section on the General tab of the Data Entry Menu.

**The PDF Attachment Process**

Three main steps are involved in the PDF attachment process in Drake:

1. Creating a PDF file to be attached
2. Informing the program that a PDF file will be sent with the return
3. Attaching the PDF file for e-filing

These steps are described in the following sections.

**Creating a PDF File**

To create a PDF file:

1. Scan the document to be attached to the return as a PDF document.

**Tip** It’s a good idea to use the DDM scanning feature for this step.

2. Save the document to your client’s DDM file, your computer’s desktop, or anywhere you can readily find it.

**Note** Many types of documents (for instance, documents created in Microsoft Word) can be printed or “saved” as PDF files if you have a PDF printer (such as Adobe Reader) installed.

**Adding PDF Files**

To indicate in the software that a PDF file will be sent with the return:

1. Go to the PDF screen in data entry.
2. Fill out the columns on the screen. See Table 3 for examples.

Table 3: PDF Attachment Window Columns

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference Source</td>
<td>Name or number of regulation, publication, or form instruction that makes attachments necessary</td>
<td>- IRS Pub xxx-1.4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Form Instructions for 1120</td>
</tr>
<tr>
<td>Description</td>
<td>Description of form or document to be attached</td>
<td>- Title of house on Oak Street</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Appraisal of Lot 1234</td>
</tr>
<tr>
<td>File name</td>
<td>Distinctive, easily recognizable file name, followed by &quot;.pdf&quot;</td>
<td>- TitleHouseOakSt.pdf</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- AppraisalLot1234.pdf</td>
</tr>
</tbody>
</table>

3. Exit the PDF screen.

Because you’ve indicated that a PDF file is attached, the program generates an EF message regarding the attachment when the return is calculated.

To attach a PDF file to a return:

1. From the return, click View. If anything was entered on the PDF screen (see Figure on page 36), there will be three PDF-related items in the View/Print window:
   - A red MESSAGES alert (see item 1 in Figure 17)
   - An EF_PDF~ worksheet that lists all items entered on the PDF screen (see item 1 in Figure 17)
   - An Attach PDF button on the toolbar (item 2 in Figure 17)

2. Click the MESSAGES file to view the EF Message, which provides information on how to attach the required documents to the return.

3. Click the Attach PDF button in the toolbar at the top of the window. The EF PDF Attachments window (Figure 18 on page 38) displays the information entered on the PDF Attachments window in data entry. A red X means the document has not yet been attached; a green check mark indicates an attached document.
4. Click the row of a document to attach (one with a red X).
5. Click Browse.
6. Browse to the proper folder, select the PDF file to attach, and click Open (or double-click the file name).

Repeat for all documents with a red X. When all documents have been attached to a completed return, recalculate the return to make sure all EF messages have been cleared. If so, the return is ready to be e-filed.

Form 3115, Application for Change in Accounting Method

Form 3115, Application for Change in Accounting Method, is an application to the IRS to change either an entity’s overall accounting method or the accounting treatment of any material item.

New for 2014: Form 3115, Application for Change in Accounting Method, is eligible for e-file.

Drake customers can fill out and e-file Forms 3115 and related schedules and attachments for corporation returns. This section provides instructions for completing this form and related schedules and attachments in Drake.

In some cases, Form 3115 must still be paper-filed. See “Parts I and III,” starting on page 40, for details.

Applicants filing Form 3115 should refer to Rev Proc. 2015-13 for general automatic change procedures, and to Rev Proc. 2015-14 for a list of automatic changes to which the automatic change procedures in Rev. Proc. 2015-13 apply.

Accessing Screens for Changing Accounting Method

Several screens may be required to complete Form 3115. These screens are accessible from the Change in Accounting Method box, located under the first Other Forms tab of the Data Entry Menu (Figure 19 on page 39).
Figure 19: Screens for Form 3115, Application for Change in Accounting Method

The screens accessible from the Change in Accounting Method section include:

- **Screen 3115 (Change in Accounting Method)** — Used to access fields for Form 3115, including Schedules A through D
- **Screen 311E (Schedule E)** — Used to request a change in depreciation or amortization methods
- **Screen ATT (Explanations and Attachments)** — Used to create and view certain attachments to be generated by the software
- **Screen ATT2 (Pt II Ln 12 & Pt III Ln 23b Attachment)** — Used to complete certain parts of Form 3115 that require specific attachments

**Multi-form Codes**

All 3115 and related screens contain a Multi-form code text box (shown in Figure 20 on page 40) that allows you to link a screen or attachment to a particular Form 3115.

If submitting more than one Form 3115, assign a multi-form code to each new application you create in Drake. The first should be 1, the second 2, and so on. When using other screens, such as the 311E or ATT screens, you can use those numbers to indicate which instance of Form 3115 the 311E or ATT screen should be associated with.

**NOTE**

If only one Form 3115 is being submitted, you do not need to enter anything in the Multi-form code box.

**Form 3115 Screens**

When you open the 3115 screen from the Data Entry Menu, the program displays the first of five 3115 screens. These five screens are:

- **Parts I, III** (Form 3115, Parts I and III)
- **Parts II, IV** (Form 3115, Parts II and IV)
- **A, B, C** (Form 3115, Schedules A, B, and C)
• D - I, II (Form 3115, Schedule D, Parts I and II)
• D - III (Form 3115, Schedule D, Part III)

As shown in Figure 20, you can access these 3115 screens by clicking a link at the top of any other 3115 screen.

The next few sections of this document provide instructions for completing the various screens for Form 3115 (including Schedules A through D).

**Parts I and III**

Use the Parts I, III screen to complete the following sections of Form 3115:

• General Information
• Part I, Information For Automatic Change Request
• Part III, Information For Advance Consent Request

**NOTE**

Information should be entered in either the Part I section or the Part III section, but not both.

Complete all applicable fields in the General Information section. Note that the fields for business activity and tax-year change are override fields (Figure 21). Complete these fields only if you want to override the equivalent information entered on screen 1 or screen K.

On the Type of accounting method change being requested line, select Depreciation or amortization, or Financial products and/or financial activities. If request-
ing another method, describe it in the **Other** text box. (The text box is limited to 20 characters.)

For advance consent requests, state in the **Other** text box the type of method change being requested and a short description of the change (for example, LIFO to FIFO.)

For automatic change requests, these informational requirements are satisfied by properly completing Part I, lines 1a and 1b of Form 3115. (See "Part I," following.)

**NOTE**

**Part I**  
From the drop list on line 1a, choose a **Designated accounting method change number**. If the method is not listed, enter the method on line 1b, in the **Other** text box.

The IRS issued Rev. Proc. 2014-16 to explain how taxpayers can elect to automatically change their accounting methods in order to comply with provisions of the final capitalization regulations. Rev. Proc. 2014-54 further explains how taxpayers can elect to automatically change their accounting methods for the disposition of property in order to conform with the regulations relating to the disposition of capital assets.

Other resources include Drake’s Knowledge Base article 13402. (For information on using the Drake Knowledge Base, see Chapter 10 of *Drake Software User’s Manual: Tax Year 2014*.)

If any of the scope limitations of section 4.02 of Rev Proc. 2008-52 apply, mark the **Yes** check box on line 2.

By answering **Yes** on line 2, you are stating that the Appendix of Rev. Proc. 2002-9 or the procedures in other published guidelines specifically state that the scope limitations are applicable to the required accounting method change.

If you answer **Yes** on line 2, you must complete all the lines in **Part II, Information for All Requests**. (Click the **Parts II, IV** link at the top of the screen to access Part II.)

See Form 3115 instructions for more information.

After answering 1a, 1b, and 2 in **Part I - Information for Automatic Change Request**, click the blue **Parts II, IV** tab at the top of the screen.

**Part II**  
In **Part II – Information for All Requests**, answer question 3 (see Figure 22 on page 42). If the answer is **Yes**:

- Ordinarily, the IRS will not consent to a request for a change in method of accounting for the applicant’s final tax year. If the applicant ceases to engage in the trade or business to which the desired change in accounting method relates or terminates its existence in the year of change, the applicant is ordinarily not eligible to make the change under automatic change request procedures unless the applicable section of the Appendix of Rev. Proc. 2011-14 or other applicable pub-
lished guidance states that section 4.02(5) of Rev. Proc. 2011-14 does not apply to the requested change in method of accounting. If the change is requested under the advance consent procedures, the IRS National Office will consider the reasons for the change in the applicant’s final year (see Part III, line 21) in determining whether to approve the requested change.

- See IRS Form 3115 instructions for details.

![Figure 22: Automatic Change Request information](image)

**NOTE**

Not all applicants are eligible to use the automatic change request procedures.

**Part III**

If this section of the **Parts I, III** screen is filled out, Form 3115 cannot be e-filed with the return. It must instead be paper-filed **before** submitting the return. A user fee (a check or money order payable to the IRS) must be included with the paper-filed form.

See Appendix A of Rev. Proc. 2012-1 for more information. For more on applicants who must apply for advance consent, see the IRS Form 3115 instructions.

Taxpayers filing under an automatic change request procedure do not pay a user fee.

If the applicant qualifies for a **reduced** user fee, enter a check mark on line **23b** and go to screen **ATT2** to complete the attachment information for Part III, line 23b (located in the bottom half of the screen). Include the necessary information or certification required by Rev. Proc. 2013-1 (or its successor).

Specific statements must also be attached to the return if the applicant answers **Yes** for line **18** (“Is change request allowed under automatic change?”) or **No** for line **22** (“All members of consolidated group use proposed method?”). Press F1 in a specific field for more information on attachment requirements. The method for attaching statements in Drake is covered in “Binary Attachments” on page 36.

**Multiple Accounting Method Changes**

If requesting multiple automatic accounting method change requests on one Form 3115, go to screen **3115** and in the **Part 1–Information for Automatic Change Request** section, make a selection from the drop list on line 1a, then use the drop lists below line 1a (see Figure 23 on page 43) to select account method changes being requested.
Figure 23: Making multiple automatic accounting method change requests

On page 1 of Form 3115, the “Other” check box under “the type of accounting method change being requested” will be marked and a note indicating that multiple automatic change requests (“MULTI AUTO CHNG RQST”) have been made (#1 in Figure 24), and the designated change numbers of the requests appear in the “Description” field of Part 1 (#2 in Figure 24).

Figure 24: Accounting change requests noted on Form 3115

Parts II and IV

In addition to the Multi-form code text box, the Parts II, IV screen consists of the Part II and Part IV sections, used to complete the following sections of Form 3115:

- Part II, Information For All Requests
- Part IV, Section 481(a) Adjustment

Applicants must complete both sections of this screen. For more information on each line (including instructions for any required attachments), press F1 in a specific field.

Part II, Line 12

Note that there is no field on the Parts II, IV screen for Part II, line 12. Instead, a link to screen ATT2. Fields for line 12, which should be completed if the applicant is changing only the accounting method for a particular item or items, are located in the top half of ATT2 screen. Use these fields to enter information on:

- The items being changed
- The applicant’s present and proposed methods for the items being changed

The applicant’s present overall method of accounting (cash, accrual, or hybrid)

Note that the bottom half of the ATT2 screen is for completing Part III, line 23b. Only the top half (for Part II, line 12) must be completed for Part II, line 12.
Schedules A, B, and C

Use the A, B, C screen to complete the following sections of Form 3115:

- Schedule A, Change in Overall Method of Accounting (screen covers Part 1, Change in Overall Method)
- Schedule B, Change to the Deferral Method for Advance Payments
- Schedule C, Changes Within the LIFO Inventory Method (screen covers both Part I, General LIFO Information, and Part II, Change in Pooling Inventories)

NOTE Schedule A, Part II (Change to the Cash Method for Advance Consent Request) requires attachments and is not addressed on the A, B, C screen.

Schedule A

This section is required for all applicants filing to change their overall method of accounting. It requires the entry of amounts as they were at the close of the tax year preceding the year of the requested change.

NOTE Leave blank any lines that aren’t required for the entity’s application. Exclude amounts not attributable to the change in method of accounting—for example, amounts that correct a math or posting error, or that correct errors in calculating tax liability.

The IRS requires a worksheet for lines 1a, 1c, 1d, 1e, and 1f of Schedule A. When you enter an amount on any of these lines in Drake, a CTRL+W worksheet is automatically opened, allowing you to begin entering the descriptions and amounts of multiple items for the worksheet. When you close a CTRL+W worksheet, the program returns to the original screen and displays the total in the field. The field is shaded (default is red) to indicate that a CTRL+W worksheet has been used.

NOTE If nothing is entered in a Schedule A field, the program automatically displays the word “NONE” in the field on the generated form.

Schedule B

This section has just two lines, both referring to the request for deferral for advance payments:

- **Line 1** — Request change to the deferral method for advance payments (from section 5.02 of Rev. Proc. 2004-34)
- **Line 2** — Request change to the deferral method for advance payments (from section 1.451-5(b)(1)(ii))

See IRS Form 3115 instructions for more information on making these requests.

Schedule C

This section has two parts:

- **Part I** (General LIFO Information) — This section is made up of attachment links. If any of the conditions on lines 1–6 match the entity’s situation, click the corresponding attachment link to access the ATT screen, where you can complete the required statement. (Select the corresponding line code from the Schedule drop list on the ATT screen.)
- **Part II** (Change in Pooling Inventories) — Enter the descriptions of the contents and the base years of the present and proposed pools. If any of the conditions on
lines 2–4 match the entity’s situation, click the corresponding attachment link to access the ATT screen, where you can complete the required statement.

**Schedule D, Parts I and II**

Use the D - I, II screen to complete the following parts of Form 3115, Schedule D, Change in the Treatment of Long-Term Contracts Under Section 460, Inventories, or Other Section 263A Assets:

- Part I, Change in Reporting Income From Long-Term Contracts
- Part II, Change in Valuing Inventories Including Cost Allocation Changes

**NOTE**

If an entity is currently using a LIFO inventory method or submethod and is changing to another LIFO inventory method or submethod, Part II of Schedule D is not applicable. Use Schedule C, Changes Within the LIFO Inventory Method, instead.

**Schedule D, Part I**

A long-term contract refers to any contract for the manufacture, building, installation, or construction of property that is not completed in the tax year in which it is entered into. Answer the questions in Part I that apply to the entity’s situation.

**Schedule D, Part II**

This section concerns changes in the identification and valuation methods of inventories. Note that some lines require attachments. To access the ATT screen and complete a required statement, click the desired attachment link.

The items on this part of the screen match the items on the actual Form 3115, Schedule D. For information on completing individual lines, see the Form 3115 instructions.

If the entity is unable to furnish a copy of Form 970 (line 5a), the attachment must include the following statement:

**NOTE**

“I certify that to the best of my knowledge and belief (name of applicant) properly elected the LIFO inventory method by filing Form 970 with its return for the tax year(s) ended (insert date(s)) and otherwise complied with the provisions of section 472(d) and Regulations section 1.472-3.”

**Schedule D, Part III**

Use the D - III screen to complete Part III (Method of Cost Allocation) of Form 3115, Schedule D. Part III is required for any entity submitting either Part I or Part II. Screen D - III consists of the following sections:

- Section A, Allocation and Capitalization Methods
- Section B, Direct and Indirect Costs Required to be Allocated
- Section C, Other Costs Not Required to be Allocated

**Section A**

Click the D3-1 Attachment link (see Figure 25 on page 46) to attach a description of the present and proposed methods used to capitalize direct and indirect costs.
Sections B and C consist of a series of drop lists under a Present column and a Proposed column. “Present” refers to the current accounting method, while “proposed” refers to the requested change in accounting methods. You should address only the items necessary; do not make a selection for any item for which an answer is not required for the entity’s situation.

For each item in sections B and C, you can:

- **Select X** — If you select X, the corresponding box on Form 3115 will be marked with an X. (See Figure 26.)
- **Select B** — If you select B, the corresponding box on Form 3115 will be left blank and an attachment will be required explaining why the line was left blank. (EF messages will outline which statements are missing.
- **Select nothing** — If you select neither of the above options, “N/A” will appear in the corresponding box on Form 3115. No attachment is necessary for a box marked “N/A.”

To attach a statement for section B or C, click the D3-2 Attachment link at the top of Section B (Figure 27 on page 47). A single statement may contain all necessary explanations for sections B and C.
Importing Trial Balance Information

Drake’s trial balance import feature allows data to be imported into an 1120 return from a trial balance worksheet. The trial balance template and importing function has the following benefits:

- Eliminates the need to duplicate entries
- Reduces data entry errors by automatically importing data to the correct fields
- Allows preparers to merge basic accounting functions with tax preparation

**NOTE**
A flow chart of the trial balance importing process is available as an appendix at the end of this manual.

Preparing to Use Trial Balance Import

The trial balance import function can be used only on returns that were created in Drake 2008 or later. If you haven’t already, create a client file in Drake or update an existing client file from the prior year. Like several other functions of the tax software, this feature requires Microsoft Excel (version 2000 or later).

In addition, take these actions to ensure the trial balance import works properly:

- **Enable Macros** — The trial balance import function uses macros in Microsoft Excel. Check your Excel settings to ensure that macros are activated and that macro security is set to “medium.” To do so, go to Tools > Options in Excel and select the Security tab. Click Macro Security and select Medium, then click OK.

  **NOTE**
  In Excel 2007 and 2010, click the Office button in the upper left and then click the Excel Options button at the bottom of the window. (In Excel 2013, click the File tab then select Options from the menu on the left.) Next, select Trust Center from the list at left, then click the Trust Center Settings button. Select Macro Settings from the list on the left, then choose Disable all macros with notification. Click OK and then OK.
• **Disable Autobalance** — When autobalance is disabled in Drake, the program is prevented from automatically adjusting the year-end retained earnings or capital amounts, thus allowing you to see any discrepancies in the balance sheet. To disable autobalance, go to the PRNT screen and select **Turn off autobalance**.

• **Force Schedule L** — By default, the program does not display the balance sheet amounts on the return if the entity does not meet the filing requirement. If this is the case, you must override the default in order to have the amounts shown on Schedule L. To force the Schedule L amounts to be printed, go to the PRNT screen and select the applicable check box (Figure 28).

![Figure 28: Check box for forcing Schedule L](image)

• **Check for Detail Worksheets** — The trial balance import allows only those detail worksheets required by the IRS. Check updated returns for detail (CTRL+W) worksheets that are not required. For example, the IRS does not require a detail worksheet for the **Gross receipts or sales** field on the INC screen; if a return has a detail worksheet for that field, the trial balance will not be imported correctly into the return. Detail worksheets are indicated by red shading, as shown in Figure 29.

![Figure 29: Example of an “unnecessary” detail worksheet](image)

Remove unnecessary detail worksheets prior to import. See “Detail Worksheets” on page 50 for more information on using detail worksheets in the trial balance.

## Preparing Financial Data for Import

To prepare the financial data for importing into the return, the data must be entered into Drake’s specially designed trial balance template. Once this information is entered and saved, it can be imported into the return.

### Opening a Template

The first step in preparing financial data for importing is to open a trial balance template for the return and enter the financial data.

To open a trial balance template for a return:
1. Open the return to the Data Entry Menu.
2. Click Import > Trial Balance Import from the toolbar. The preliminary Trial Balance Import dialog box is opened.
3. Click Create New or Open Existing. If opening an existing file, click Open after selecting the correct file.
4. If a Security Warning box appears, click Enable Macros.

NOTE In Excel 2007 and 2010, you may see a Security Warning message with an Options button. Click Options to open the Security Options dialog box, then select Enable this content. Click OK. (In Excel 2013, click Enable Content.)

The trial balance template is displayed in Microsoft Excel.

Naming Convention Whenever a new template is opened, the tax software assigns it a default file location and name. Trial balance templates are saved in the TB folder of your Drake14 software. The file name consists of the client name as entered in Drake, plus “TB” for “trial balance,” plus the “.xls” extension assigned to all Excel files, as shown in Figure 30.

![Figure 30: Example of trial balance template file name](image)

To change the name of a file in Excel, select File > Save As and assign the new name.

NOTE If saving a trial balance to a different location, make a note of where you are storing it. The program automatically looks in the default directory.

Template Structure The trial balance template consists of three title rows and six columns. The Entity Name and Year End title rows can be edited; double-click a row to change the title. Columns are described in Table 4.

Table 4: Trial Balance Template Columns

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Title</td>
<td>Title of account</td>
</tr>
<tr>
<td>Debit/Credit</td>
<td>Debit and credit amounts</td>
</tr>
<tr>
<td>Import to</td>
<td>Screen and line in Drake to which the debit or credit amount is imported</td>
</tr>
<tr>
<td>Form, Page, Sch, and/or line</td>
<td>Location of the amount on the printed return</td>
</tr>
</tbody>
</table>
Table 4: Trial Balance Template Columns

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Other Information</td>
<td>Additional details for preparers; see “Details for Preparers” on page 53.</td>
</tr>
</tbody>
</table>

Displayed at the bottom of the trial balance worksheet are the calculated amount for Schedule M-1, line 1; the credit and debit totals; and a cell showing whether or not the balance sheet is out of balance and, if applicable, the out-of-balance amount (Figure 31; see also Figure 34 on page 52).

![Figure 31: Schedule M-1 amount (1); totals (2); and indication of balance (3)](image)

Following are instructions and guidelines for using the trial balance template to assemble financial data for importing into data entry.

**Entering Financial Data**

When a new trial balance file is opened for a return, all debit and credit amounts are zero ($0). All data must be entered manually into the template.

**NOTE**

Some data cannot be imported from the trial balance worksheet and must be entered directly into the data entry fields within the program. For more on these categories of data, see “Special Conditions” on page 53.

**Direct Entry**

Most cells in the trial balance worksheet are view-only. In a new template, editable debit and credit cells are indicated by a dollar amount ($0).

**Detail Worksheets**

Some cells require more detail than can be entered on a single line. These cells are indicated by buttons (Figure 32 on page 51). (Buttons do not work if macros are disabled; see “Opening a Template” on page 48.)
Click a worksheet button to open a worksheet in a new tab. Figure 33 shows an example of the “Other Income” worksheet.

Figure 33: Trial balance worksheet for “Other Income”

To return to the previous worksheet, click the Corp TB tab (labeled “1” in Figure 33), or the Click to Return button above the worksheet tabs (labeled “2” in Figure 33). Note that a detail tab (the “Other Income Detail” button labeled “3” in Figure 33) might include one or more detail worksheets.

**NOTE**
Do not create detail worksheets in data entry if the trial balance worksheet does not provide an equivalent detail worksheet. Otherwise, the trial balance will not be imported correctly.

**Totals**
Totals are displayed at the bottom of each worksheet. If credit and debit columns are out of balance, the worksheet highlights the out-of-balance amount (Figure 34).
In addition to credit and debit totals, the main trial balance worksheet shows the net income (loss) to be calculated for line 1 of Schedule M-1 after all entries and adjustments are made in the software (see Figure 28 on page 48).

**NOTE** The data cannot be imported if the worksheet is out of balance.

### Saving a File

To save a file, click the **Save** icon or select **File > Save** from the menu bar. To re-name a file when saving, select **File > Save As**. For more information on file names in the trial balance program, see “Naming Convention” on page 49.

### Importing Data into a Return

**NOTE** Not all trial balance data can be imported directly into a return. For information on program limitations, see “Special Conditions” on page 53.

Once a trial balance worksheet has been set up for a client in Drake, the trial balance information can be imported into the program and calculated into the return.

**NOTE** If you are already in the Trial Balance Import tool for the selected return, go to the **Trial Balance Import** window in Drake and start at Step 3 of the following procedure.

To import a trial balance into a return:

1. Open the return to which you will import the trial balance information.
2. Click **Import > Trial Balance Import** from the menu toolbar. The preliminary **Trial Balance Import** dialog box is opened. Click **Next**.
3. Enter or select the trial balance file to be imported. Use the **Browse** feature if necessary. By default, each trial balance file is an Excel (.xls) file showing the client name and ending in “TB” for trial balance, as shown in the example in Figure 35 on page 53. (See “Naming Convention” on page 49.)
4. Select the **Trial Balance Additional Import Options**. (See “Additional Import Options” following this procedure.)

5. Click **Next** and wait for the import to be completed.

6. Click **Finish**.

The program returns to the **Data Entry Menu** for the open return. Note that all selected data from the trial balance worksheet has been imported into the return. This can be seen both in the data entry screens and on the generated return.

---

**Additional Import Options**

The program can import the following additional information when importing the trial balance data: (Select the items to import or click **Select All**.)

- Buildings & other depreciable assets
- Accumulated depreciation
- Goodwill & other intangible assets
- Land
- Accumulated amortization
- Cost of goods sold (COGS) depreciation

---

**Special Conditions**

Some trial balance items cannot be entered into the trial balance worksheet and must be typed directly into Drake data entry. Other items should be entered into the worksheet for balance purposes but are not carried to data entry; these must be entered separately and the calculated results compared to the trial balance worksheet.

---

**Details for Preparers**

Most trial balance items go directly to the location indicated in the program and on the return. For example, the amounts shown in Figure 36 go to Schedule L, line 1, column d in the program and are shown on page 5, line 1, column d of the 1120 return.

---

**Figure 35:** Selected file to import

**Figure 36:** Indication of where an amount will go in Drake and on the return
Other Info Column

The “Other Information” column in the trial balance worksheet indicates special conditions and additional information regarding certain rows. Table 5 describes the most common notes in this column.

Table 5: “Other Information” Column Notes

<table>
<thead>
<tr>
<th>Note</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>not included in totals</td>
<td>The amount is required for importing purposes only but is not included in the totals shown on the trial balance.</td>
</tr>
<tr>
<td>does not import</td>
<td>Information cannot be imported and must be entered on the appropriate screen in Drake. Screen is specified in “Form, Page, Sch...” column to the left of “Other Information.”</td>
</tr>
<tr>
<td>optional</td>
<td>Amount is optional; not required for import, but could require direct entry in the software.</td>
</tr>
<tr>
<td>enter deficit as negative number</td>
<td>Some deficits must be entered as negative numbers.</td>
</tr>
<tr>
<td>import includes the calculated change in inventory</td>
<td>Used for “total purchases;” when calculating cost of goods sold (COGS) in the return, the program takes the change in inventory into account for the Schedule A calculation.</td>
</tr>
<tr>
<td>[Form or Schedule] may be required</td>
<td>Non-financial information (such as names of officers for a Schedule E) must be completed in Drake, in addition to the financial data entered in the worksheet.</td>
</tr>
</tbody>
</table>

All “does not import” notes are accompanied by further instructions in the column to the left of the “Other Information” column, as shown in Figure 37.

SCH2 Detail

Typically, a balance sheet subsidiary schedule (SCH2 detail screen for Schedule L) is required for an item marked “does not import” on the trial balance (Figure 37).

To complete an SCH2 screen required for “does not import” items:

1. Open the SCH2 screen for the return.
2. Select the line number from the Line Number drop list.
3. Enter the applicable item descriptions and beginning- and end-of-year totals.

**NOTE**

Alternately, open screen L and click the SCH2 Screen link for the line your wish to enter.

To enter details for additional lines of the Schedule L, press PAGE DOWN and repeat steps 2 and 3. Data is saved automatically upon entry.

When the return is produced, the Schedule L of the return reflects both the amounts imported from the trial balance worksheet and the totals of the amounts entered on the SCH2 screen.

**Depreciation**

On an 1120 return, total depreciation consists of COGS depreciation, which is reported on Form 1125-A, Cost of Goods Sold, and any remaining depreciation, which is reported on page 1 of the return. For trial balance purposes, enter depreciation amounts directly into the appropriate fields on the trial balance worksheet.

When the trial balance is imported, the COGS depreciation expense amount flows directly to the appropriate line of Form 1125-A on the return. Because the remaining depreciation can comprise any number of assets, the amount entered on the trial balance does not flow to the return. To ensure that each component of the total remaining depreciation is calculated into the return, each asset must be entered on the applicable depreciation screens in data entry.

Entering the remainder of the depreciation on the trial balance worksheet helps ensure that the balance sheet balances and provides a way to check that the amount on line 1 of Schedule M-1 is correct. Compare the calculated line 1 at the bottom of the trial balance to the equivalent line on Schedule M-1 of the calculated return. If the depreciation amounts match but the line 1 amounts differ, an M-1 adjustment could be required.
Appendix A: Trial Balance Import

The trial balance import allows data to be imported into a corporate tax return from a trial balance worksheet.

Drake’s specially designed trial balance template and importing function has the following benefits:

• Eliminates the need to duplicate entries
• Eliminates data entry errors by automatically importing data to the correct fields
• Allows preparers to merge basic accounting functions with tax preparation

See next page for a flow chart describing the use of the trial balance import.
Trial Balance Import: General Process

**Prepare to use Trial Balance Import**
- Enable Excel macros
- Disable autobalance
- Force Schedule L
- Delete unnecessary detail worksheets

**Populate Trial Balance Template**
(Import > Trial Balance Import)
- direct entry data (cells with $0)
- applicable detail worksheets
- totals for:
  - depreciation
  - Schedule L
  - rentals (1120S & 1065 only)

**Populate Data Entry**
Enter any trial balance data that cannot be imported via Trial Balance Import
- Screen SCH2 for Schedule L items
- Screen 4562 for individual assets (depreciation)

**Complete IMPORT**

**Did data import correctly?**
- YES: Is an M-1 adjustment necessary?
  - YES: Adjust amounts elsewhere in data entry
  - NO: Make M-1 adjustment

**Compare M-1, line 1: Does trial balance match Schedule M-1, line 1?**
- YES: Go to data entry and enter individual rentals on 8825 or RENT screens as applicable
- NO: Delete imported 8825 and RENT screens

**990, 990-EZ, or 990-PF return?**
- YES: Prepare to use Trial Balance Import
- NO: Process complete!

**1120 return?**
- YES: Were rental totals entered in trial balance?
  - YES: Make corrections in TB worksheet
  - NO: Adjust amounts elsewhere in data entry

**1120S & 1065: Were rental totals entered in trial balance?**
- YES: Make M-1 adjustment
- NO: Process complete!
Index

A
accounting method
changing 38
multiple changes 42
address
change of 6
e-mail 21
entering on Form 1120 5
adjustments and credits 29
advertising expenses 12
affiliated groups 18
alternative minimum tax (AMT) 28
amended returns 17
amortization 13, 23
APPLD FOR 3, 10
apportionment
plan status 29
attachments
binary 36–38
PDF, see PDF files
to Form 3115 38, 45
auto-balance 25, 33

B
bad debts 9, 11
bankruptcy 34
book-to-tax difference (Schedule M-1) 25
brother-sister group 28

C
calendar years 6
capital gains and losses 8
carryover of NOLs 13, 29
cash (accounting method) 44
Change in Accounting Method 38–47
multiple changes 42
change of name or address 6
Changes on-the-fly 32
charitable contributions 11, 29
codes
error/reject 34
miscellaneous (screen 1) 23
multi-form 39
state 21
combined group 28
compensation of officers 9
consolidated returns 8
contact information (for state returns) 21
contributions, charitable 11, 29
controlled groups 14, 28
converting to 1120 5
cost of goods sold, see Schedule A (Cost of Goods Sold)
coversheets 33
credit for tax on fuels 9
credits and adjustments 29
Ctrl+W (detail) worksheets 8, 13, 44, 48

data entry
trial balance import 50
debts, bad 11
deductions and income 6–13
depreciation
and auto-balance errors 25
expense 12
for cost of goods sold (Schedule A) 7
on short-year returns 6
trial balance (business returns only) 55
detail (Ctrl+W) worksheets 8, 13, 44, 48
direct debit of balance due 15–16
Domestic Production Activities 13
domestic production activities deduction 13
e-filing
new features in Drake 34
PDF documents 36–38
Elections
Safe Harbor 32
electronic
funds withdrawal (direct debit) 15
signatures (PIN) 17
entertainment and meals 13
envelope coversheets 33
error codes 34
estimated tax worksheet 33
estimates 14, 33
extensions 16, 33
filing instructions 33
final returns
   indicating in the program 6
   updating 4
fiscal year returns 6
foreign ownership 20
FOREIGNUS 3, 10
Form 1120-C (U.S. Income Tax Return for Cooperative Associations) 5
Form 1120-H (U.S. Income Tax Return for Homeowners Associations) 5
Form 2220 (Underpayment of Estimated Tax By Corporations) 14, 33
Form 3115 (Application for Change in Accounting Method) 38–47
Form 4466 (Corporation Application for Quick Refund of Overpayment of Estimated Tax) 14, 33
Form 4797 (Sales of Business Property) 9
Form 5884 (Work Opportunity Credit) 29
Form 6252 (Installment Sale Income) 8
Form 6478 (Alcohol and Cellulosic Biofuel Fuels Credit) 9, 29
Form 6765 (Credit for Increasing Research Activities) 29
Form 7004 (Application for Automatic Extension of Time to File) 16, 33
Form 8050 (Direct Deposit of Corporate Tax Refund) 14
Form 8820 (Orphan Drug Credit) 29
Form 8844 (Empowerment Zone and Renewal Community Credit) 29
Form 8845 (Indian Employment Credit) 29
Form 8846 (Credit for Employer Social Security and Medicare Taxes Paid on Certain Employee Tips) 11, 29
Form 8864 (Biodiesel and Renewable Diesel Fuels Credit) 9, 29
Form 8873 (Extraterritorial Income Exclusion) 13
Form 8881 (Credit for Small Employer Pension Plan Startup Costs) 29
Form 8903 (Domestic Production Activities Deduction) 13
Form 8912 (Credit to Holders of Tax Credit Bonds) 29
Form 8932 (Credit for Employer Differential Wage Payments) 29
Form 8941 (Credit for Small Employer Health Insurance Premiums) 29
Form 8941 (Credit for Small Employer Health-Insurance Premiums) 13

G

gains and losses 9
gross receipts 7

H

header information 5

I

importing trial balance 47–55
inactive returns 35
income and deductions 6–13
instructions for filing 33
insurance proceeds, income from 9
interest
   expense 11
   income 8, 9
inventory 7

L

life insurance companies 28
limitations
   meals and entertainment 13
   on NOL deductions 30

M

M-2 out of balance, troubleshooting 27
maintenance costs 10
meals and entertainment 13
Multi-State Apportionment 21

N

net operating losses (NOL) 13, 29
new features in Drake 1
next-year depreciation listing 33

O

officer compensation 9
ordinary gains and losses 9
Other Deductions 13
other income (loss) 9
out-of-balance M-2, troubleshooting 27
ownership
   foreign 20
   of stock 18–20
   percentages 10

P

parent-subsidiary group 18, 28
PDF documents
   e-filing 36–38
   Pension and Profit-Sharing 13
percentage, stock and ownership 10
PIN (electronic) signatures 17
printing
   statements for Schedule L 24
   suppressing/forcing 32
prior-year returns, updating 4
R
receipts 7
references to forms and worksheets 33
refunds
direct deposit of 14
state tax 9
reject codes 34
rent paid on business property 11
rental & royalty income 8
repair costs 10
resident state 23
returns
consolidated 8
converting from another type 5
fiscal and calendar year 6
updating 4
S
Safe Harbor Elections 32
salaries 10
SCH2 screen (for Schedule L) 23
Schedule A (Cost of Goods Sold) 7–8, 25
Schedule B (Additional Information for M-3 Filers) 27
Schedule C (Dividends & Special Deductions) 8
Schedule D, Form 3115 45
Schedule E (Compensation of Officers) 32
Schedule G (Information on Certain Persons Owning the Corporation’s Voting Stock) 32
Schedule G (Schedule G (Information on Certain Persons Owning the Corporation’s Voting Stock)) 19
Schedule K 18
Schedule K, line 13 20
Schedule K, line 3 18
Schedule K, line 4 19
Schedule K, line 5 19
Schedule K, line 7 20
Schedule K-1 20
Schedule L (Balance Sheet per Books) 23–25, 32
Schedule M-1 (Reconciliation of Books with Return) 25, 32
Schedule M-2 (Unappropriated Returned Earnings) 27, 32
Schedule M-3 (Reconciliation of Books with Return) 26
Schedule O (Consent Plan & Apportionment Schedule for a Controlled Group) 28
section
263A costs 7
481 9
short-year return 6
signatures, electronic (PIN) 17
signing the return 17
state
codes 21
tax refunds 9
T
tax
alternative minimum (AMT) 28
and payments 13
-exempt interest 8
on fuels (credit for) 9
-to-book difference 25
years (fiscal vs calendar) 6
taxes and licenses 11
trial balance import 8, 23, 24, 47–55
troubleshooting the M-2 27
U
underpayment of estimated tax 14
updating a prior-year return 4
V
vouchers 14
W
wages 10
This page intentionally left blank.